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AT32 Printf Debug Demo

Introduction

It is common for the user to check the debug process information in the process of application code
debug. In most cases, this action can be done through the serial port debugging assistant.
However, it would be a headache for users to try to observe the testing process information when
the serial port assistant is not supported by the hardware.

To address the above concerns, this application note provides a complete set of example codes
describing how to output the debug process information, especially when the serial port debugging

assistant is not available.

Note: The corresponding code in this application note is developed on the basis of V2.x.x BSP provided by
Artery. For other versions of BSP, please pay attention to the differences in usage.
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1 Overview

This application note describes how to use the printf function of AT chips in the environment of Keil
and IAR. There are six methods to be listed in the table below, with each of them being detailed in
this document.

Table 1. AT MCUs printf function use methods

AT MCUs printf function use methods
No. Environment | Description Remark
Method 1 AR Printf via Terminal 1/0 See 3.1
Method 2 Redirect Printf as serial ports See 3.2
Method 3 Printf via Debug (printf) Viewer See 3.3
Method 4 | Keil Redirect Printf as serial ports (using MicroLIB) See 3.4
Method 5 Redirect Printf as serial ports (not use MicroLIB) See 3.5
Method 6 | IAR/Keil Printf via JLinkRTTClient window See 3.6

2021.12.07 6 Ver 2.0.0
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2.1
2.1.1

2.1.2

2.1.3

2.1.3.1

2.1.3.2

2.1.4

2141

2.1.4.2

2.1.5
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Detailed information
Printf via Terminal I/O in IAR

Introduction

The IAR driver linked to the Terminal contains standard input and output driver functions such as
scanf and printf so that the information interaction of the project files can be done via the Terminal
I/O.

Example code
001_Printf_Test_IAR_Terminal\projectiiar_v8.2
Environment and hardware

Development environment

This method is used in the IAR environment. The compiling environment used in the example code
is IAR_V8, with the hardware board AT-START-F403A_V1.2.

Hardware connection

J-Link/AT-Link&... connection

Table 2. Hardware connection (without JTDO)

Hardware connection (without JTDO)
No. | AT-START-F403A_V1.2 | J-Link/AT-Link&... Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 GND GND None
Software

Header file
Add the “stdio.h” to the code project files.
Redirection settings

Unlock the redirection of Printf (shield the Printf from the actual serial interface).
Debug and download

Compile and download to the MCU, then enter the debug environment to call up the virtual terminal
through View->Terminal I/O (Figure 1), and run the code at full speed, then the “Hello World” is

7 Ver 2.0.0
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visible in the Output column (Figure 2), and the data in the Input column is also displayed in this

window.
Figure 1. Virtual terminal window path
© Template - IAR Embedded Workbench IDE - Arm 8.22.2
File Edit | View | Projec Debug Disassembly J-Link Tools
N O e Messages ric
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Figure 2. Virtual terminal interaction window
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2.2 Redirect Printf as serial ports in IAR

2.2.1 Introduction

Redirect the Printf function to a set of actual serial ports in the chip, and output via TX pin and
finally implement information interaction through the serial port debugging assistant.

2.2.2 Example code
002_Printf_Test_IAR_USART2\project\iar_v8.2Environment and hardware
2.2.3 Development environment

2.2.3.1 Hardware connection

This method is used in the IAR environment. The compiling environment used in the example code
is IAR_V8, with the hardware board AT-START-F403A_V1.2.

2.2.3.2 Hardware connection

2.2.3.2.1 J-Link/AT-Link&... connection
J-Link/AT-Link&... connection

Table 3. Hardware connection (without JTDO)

Hardware connection (without JTDO)
No. AT-START-F403A_V1.2 | J-Link/AT-Link&... | Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 GND GND None

2.2.3.2.2 USART2 connection

Table 4. Hardware connection (USART)

Hardware connection (USART)
No. AT-START-F403_V1.2 USB_To_TTL(CH340) Attention
1 GND GMD None
2 PA2 RXD None
3 PA3 TXD None

2021.12.07 9 Ver 2.0.0
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2.2.4 Software

2.2.4.1 Header file
Add the “stdio.h” to the code project files.
2.2.4.2 Redirection settings

Initialize the serial ports and redirect the Printf function to the actual serial ports. The redirection
function is as follows:

PUTCHAR_PROTOTYPE

{

USART_SendData( USARTZ2, ch);
while (USART_GetFlagStatus( USART2, USART_FLAG_TRAC) == RESET );

return ch;

}
2.2.5 Debug and download

Compile the code and download to the MCU, and run it at full speed, then you can see that the
“Hello World” is displayed in the terminal interaction window (Figure 3).

Figure 3. Serial port debugging assistant window
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2.3  Printf via Debug(printf) Viewer in Keil

2.3.1 Introduction

The Keil platform comes with a Debug(printf) Viewer that can be used for standard Printf interaction
on the premise that the ARM core integrates standard input and output driver functions such as
scanf and printf.

2.3.2 Example code location

003_Printf_Test_Keil_JTDO\projectimdk_v S5Environment and hardware
2.3.3 Development environment

2.3.3.1 Environment

This method is used in the Keil environment. The compiling environment used in the example code
is Keil_V5, with the hardware board AT-START-F403A_V1.2.

2.3.3.2 Hardware connection

J-Link/AT-Link&... connection

Table 5. Hardware connection (with JTDO)

Hardware connection (with JTDO)
No. AT-START-F403A_V1.2 | J-Link/AT-Link&... | Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 PB3 JTDO Must Pull up external
6 GND GND None

2.3.4 Software

2.3.4.1 Header files

Add the “stdio.h” to the code project files.

2.3.4.2 Trace pin assignment

DEBUG->ctrl_bit.trace_ioen = FALSE;
DEBUG->ctrl_bit.trace_ioen = TRUE;

2021.12.07 1" Ver 2.0.0
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2.3.4.3 Printf mapping

int fputc(int ¢, FILE *f)
{
if (c=="n")
{
SER_PutChar(\r');

}
return (SER_PutChar(c));

}
int SER_PutChar (int c)

{
ITM_SendChar(c);

return (c);

}

2.3.5

Debug and download

Tick the Enable box (Figure 4) and set the Core value, and the Core value must be equal to the
system clock.

Configure the serial clock by checking the Autodetect max SWO C1 box (Figure 4). If garbled
characters are displayed, untick the Autodetect max SWO C1 box and manually modify the
Prescale Core Clk to ensure that the printed information is correct.

Compile the code and download to the MCU, and then enter debug environment to call up the
virtual terminal window through View->Serial Windows->Debug (printf) Viewer (Figure 5); then run
the code, and “Hello World” is visible in the terminal interaction window (Figure 6).

Figure 4. Trace target driver setup
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Figure 5. Keil virtual terminal window path
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2.4  Redirect Printf as serial ports in Keil (using MicroLIB)
2.4.1 Introduction

The Keil environment comes with a MicroLIB that contains some codes supporting Printf function.
Tick the MicroLIB option to implement information interaction through the serial port debugging
assistant when the Printf is redirected to the serial ports.

2.4.2 Example code

004_Printf_Test_Keil_USART2_MicroLIB\projectimdk_v5
2.4.3 Environment and hardware

2.4.3.1 Environment

This method is used in the Keil environment. The compiling environment used in the example code
is Keil_V5, with the hardware board AT-START-F403A_V1.2.

2.4.3.2 Hardware connection

2.4.3.2.1 J-Link/AT-Link&... connection

Table 6. Hardware connection (without JTDO)

Hardware connection (without JTDO)
No. AT-START-F403A_V1.2 | J-Link/AT-Link&... Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 GND GND None

2.4.3.2.2 USART2 connection

Table 7. Hardware connection (USART)

Hardware connection (USART)

No. | AT-START-F403 V1.2 USB_To_TTL(CH340) Attention

1 GND GMD None
2 PA2 RXD None
3 PA3 TXD None

2.4.4 Software

2.4.4.1 Header files
Add the “stdio.h” to the code project files.

2021.12.07 14 Ver 2.0.0
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2.4.4.2 Redirect Printf

PUTCHAR_PROTOTYPE
{
USART_SendData( USART2, ch);
while ( USART_GetFlagStatus( USART2, USART_FLAG_TRAC) == RESET );
return ch;

}

2.4.4.3 MicroLIB settings

Figure 7. MicroLIB settings

2.4.5

2021.12.07

Options for Target 'sleep_usart1’ ]
Device Target IUulput | Listing | User I C/CH | Asm | Linker | Debug | Utilities]

ArteryTek -AT32F403AVGT7 Code Generation
ARM Compiler: | Use default compiler version 5 v |

Xal (MHz): [12.0

Operating system:  [None ~I [~ Use Cross-Module Optimization

System Viewer File: | ¥ Use MicroLIB i

IJ-T:':F“':EA‘:'Z—"Z svd J Floating Point Hardware: [ Single Precision Z|

[™ Use Custom File

Read/Only Memory Areas Read/Write Memory Areas

default  off-chip Start Size Startup | | default offchip Start Size Nolnit
™ RoMt: | | c ™ RAMI | [ r
~  rom2 | | ® ™ RAM2 | [ r
™ RoM3: | [ ® ™ RAM3: | [ r

on-chip on-chip

¥  IROM1: [x8000000  [0x100000 & ¥ IRAM1: [0<20000000 [0x38000 r
™ IRoM2: | [ e ™ IRAM2: | [ r

Debug and download

Compile the code and download to the MCU; then run the code at full speed, and you can see that

“Hello World” is displayed in the terminal interaction window (Figure 8).
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Figure 8. Serial port interaction window
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2.5
2.5.1

2.5.2

2.5.3

2531

2.5.3.2

Redirect Printf as serial ports in Keil (not use MicroLIB)

Introduction

The Keil environment comes with a MicroLIB that contains some codes supporting Printf function.
When the Printf is redirected to the serial ports and the MicroLIB option box is not ticked, the
information interaction can be done through the serial port debugging assistant after adding the
codes that supports Printf to the project files.

Example code

005_Printf_Test_Keil_USART2__Without_MicroLIB\projectimdk_v5
Environment and hardware

Environment

This method is used in the Keil environment. The compiling environment used in the example code
is Keil_V5, with the hardware board AT-START-F403A_V1.2.

Hardware connection

2.5.3.2.1 J-Link/AT-Link&... connection

Table 8. Hardware connection (without JTDO)

Hardware connection (without JTDO)
No. AT-START-F403A_V1.2 | J-Link/AT-Link&... Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 GND GND None

2.5.3.2.2 USART2 connection

Table 9. Hardware connection (USART)

Hardware connection (USART)
No. AT-START-F403A_V1.2 USB_To_TTL(CH340) Attention
1 GND GMD None
2 PA2 RXD None
3 PA3 TXD None

2.5.4 Software

2.5.4.1 Header files

Add the “stdio.h” to the code project files.

2021.12.07
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2.5.4.2 Redirect Printf

PUTCHAR_PROTOTYPE
{
USART_SendData( USART2, ch);
while ( USART_GetFlagStatus( USART2, USART_FLAG_TRAC) == RESET );
return ch;

}

2.5.4.3 MicroLIB settings

Figure 9. MicroLIB settings

I Options for Target 'sleep_usartl’ [=
Device Target |Dutput | Listing| User |C/C+t | Asm | Linker | Debug | Utilities|
AteryTek -AT32FA03AVGT7 Code Generation
ARM Compiler: lUsedefault compiler version 5 __v_|
Xal (MHz): [12.0
Operating system: | None _] I™ Use Cross-Module Optimization
System Viewer File: | [~ Use MicroLIB | =
]%TZZF:C?#;@:_;E svd J Floating Point Hardware: ISingle Precision LI
™ Use Custom File
Read/Only Memory Areas Read/Write Memory Areas
default offchip Start Size Startup default off-chip Start Size Nolnit
~  Rom: | | ' ~ Rram: | [ r
r  Rom2 | [ e I~ RAm2 | ] r
™ ROM3: | | @ ™ RAM3: | | r
on-chip on-chip
@  IROM1: |0xB000000  [0x100000 @ [  IRAM1: |0x20000000  [®x38000 r
™ IROM2: | | 9 ™ IRAM2: | ’ r

2.5.4.4 Add codes supporting Printf function

#if (_ ARMCC_VERSION > 6000000)
__asm (".global __use_no_semihosting\n\t");
void _sys_exit(int x)
{
X =X;
}
/* __use_no_semihosting was requested, but _ttywrch was */
void _ttywrch(int ch)

{
ch =ch;
}
FILE _ stdout;
#else

#ifdef CC_ARM
#pragma import(__use_no_semihosting)
struct __ FILE

2021.12.07 18
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2.5.5
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{
int handle;
2
FILE _ stdout;
void _sys_exit(int x)
{
X =X;
}
#endif
#endif#if (_ ARMCC_VERSION > 6000000)
__asm (".global __use no_semihosting\n\t");
void _sys_exit(int x)

{

/* __use_no_semihosting was requested, but _ttywrch was */
void _ttywrch(int ch)

{
ch =ch;
}
FILE _ stdout;
#else

#ifdef _ CC_ARM
#pragma import(__use_no_semihosting)
struct __FILE
{
int handle;
2
FILE _ stdout;
void _sys_exit(int x)

{

#endif
#endif

Debug and download

Compile the code and download to the MCU; then run the code at full speed, you can find that the
“Hello World” is displayed in the terminal interaction window (Figure 10).
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Figure 10. Serial port interaction window
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Printf via JLInNkRTT

Introduction

JLink has its own debug output function that can debug the code and output to the corresponding
window according to the specified instructions after the JLink RTT library code is added.

Example code
006_Printf_Test_Jlink_RTT\projectimdk_v5
Environment and hardware

Environment

This method is used in both IAR and Keil environment. The compiling environment used in the
example code is IAR_V8 or Keil_V5, with the hardware board AT-START-F403A_V1.2.

Hardware connection

J-Link connection

Table 10. Hardware connection (without JTDO)

Hardware connection (without JTDO)
No. AT-START-F403A_V1.2 | J-Link Attention
1 3.3V 3.3V None
2 PA13 SWDIO Must Pull up external
3 PA14 SWCLK Must Pull down external
4 NRST RSTn None
5 GND GND None
Software
Header file

Add the “stdio.h” to the code project files.

Add JLink RTT library code

B Addthe SEGGER_RTT.c and SEGGER_RTT_printf.c in the JLink RTT library code to the
project files;

B Add SEGGER_RTT_Syscalls_IAR.c or SEGGER_RTT_Syscalls_KEIL.c to the project files
according to the compiling environment.
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2.6.4.3 Output to PC

Call the SEGGER_RTT_WriteString or SEGGER_RTT_printf command from the code and output
to PC.
SEGGER_RTT_WriteString(0, "SEGGER Real-Time-Terminal Sample\r\n\r\n");
SEGGER_RTT_printf(0, "printf Test: %%c, 'S' : %c.\r\n", 'S");
2.6.5 Debug and download

2.6.5.1 Printf via JLinkRTTClient window

Compile the code and download to the MCU, and enter the debug environment, open the
JLinkRTTClient application in the JLink installation path. Run the code step by step, and you can
find the print information is output to the JLInkRTTClient window, as shown in Figure 11 and Figure
12.

Figure 11. Code debug

k4 C:\Users\Hoopzhao\Desktop\FE{43\006_Printf_Test_Jlink_RTT\Project\MDK_v5\Template.uvprojx - uVision
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

SHd& s B9 e | @ | 2= = JE /5| @ set_sevonpenp EEY I EK
e laven » OREERSA-O)R-2-2- @8- -

P.. B [B Disassembly

948 P 5% SEGGER RTT printf (0, "printf Test: $3%+u, -12345 : %$+u.\r\n", -12345);
&g || |0x0800068A 4nd4 LDR r2, [pc,$272] : @0x0800079C
i 0x0800068C Al4E ADR rl, {pc}+0x13C ; @0x080007C8
0x0800068E 2000 MOVS r0, $#0x00
0x08000690 FOO1FE18 BL.W SEGGER_RTT_printf (0x080022C4)
TA. SFAGFR BTT nrintfiN  Mnrinrf Tear: 2% 2n —122345 + % 3 \r\n"  _12345) .

_) mainc ] system_at32fdocc ] stdioh ] startup_at32f403zx hd.s ] SEGGER_RTT.c
SEGGER_RTT_WriteString (0, “### Testing SEGGER_printf () \rin")

i Ko e\ “S7);

1 $PeeNnTy: TE )s

s N-Sc.\r\n'; G )

: %-6c.\r\n", ’6’):
YR

SEGGER_RTT_printf (0, “printf Test: ¥¥c,
SEGGER_RTT_printf (0, “printf Test: %%5c,
SEGGER_RTT_printf (0, “printf Test: %%-5c,
SEGGER_RTT_printf (0, “printf Test: %%5.3c,
SEGGER_RTT_printf (0, “printf Test: ¥%. 3c,
SEGGER_RTT_printf (0, “printf Test: %¥c,

: ¥-5c.\r\n”,
: Ne.Xen,, "RY)

AEQaa

A a aw

SEGGER_RTT_printf (0, “printf Test: ¥¥s, \"RIT\" : %s.\r\n“, “RTT"):
SEGGER_RTT_printf (0, “printf Test: %¥s, \"RIT\\r\inRocks.\" : ¥s.\r\n", “RIT\r\nRocks.“)|:
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Figure 12. JLinkRTTClient window output information

C:\Program Files (x86)\SEGGER\JLink_V634c\JLinkRTTClient.exe ol = | =%

Client:

Client: SEGGER Microcontroller GmbH

Client: Solutions for real time microcontroller applications
Client:

Client:

Client: {c> 2812 - 28016 SEGGER Microcontroller GmbH

Client:

Client: wWY.Segger.con Support: supportlsegger.com

Client:

L T@MIE T 50 MR BB
Client: = *

Client: »* SEGGER J-Link RTT Client Compiled Aug 23 2018 11:88:14 *
*

Connecting to J-Link RIT Server via localhos 9821 Connected.
J-Link U6.34c — Real time terminal output
J-Link ARM U%.4, SN=52485387
Process: UU4.exe
3EGGER Real-Time-Terminal Sample

i Testing SEGGER_printf (> Rl
orintf Test: xc. 'g* = 8.
orintf Test: #5c. *E* =
srintf Test: x-5c. 'G*
arintf Test: #5.3c. 'G*
orintf Test: x%.3c., *E’
orintf Test: xc, o -
orintf Test: YRTT" =
» "RIT~»“\nRocks." : RIT

2.6.5.2 Printf via JLinkRTTViewer window

2021.12.07

Compile the code and download to the MCU, and then open the JLINKRTTViewer window, as
shown in Figure 13.

Figure 13. Open JLinkRTTViewer window

N J-Link RTT Viewer V6.34c = | = =

Log #11 Terminals Terminal O

B J-Link RTT Viewer V6.34c | Configuration 7] =
Connection to J-Link
@ UZE Serial Ho
TCE/TF

Existing Session

Specify Target Device

unspeci fied - | |

Script file (optional)

Target Interface & Speed
4D - ||500 Wz |

ETT Control Blaeck

@ Auto Detection hddress Search Range

[ ok ][ Cancal

Enter || Clear

Ready. 0.00 MB

Click on “OK” and then click on “OK” again in the pop-up window; then, input and select the
flowing information (taking ZE series as an example) and click on “OK”, as shown in Figure 14.
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Figure 14. Device selection window

SEGGER J-Link V6.34c - Target device settings &2

Filker .
Manufacturer Device Care Litle endian
. | [sTM3zFiDazZE [- =] em o

Manutacturer | Device | Core ‘ MumCares | Flash size ‘ RAM size |
ST STM32F103ZE [allow opt. bytes] Cortex-M3 1 524304 Bytes B4 KB
ST STM32F103ZE Cortex-M3 1 512KB B4 KB

Select a device for J-Link.

Selecting a device iz not required for most devices, but allows mare efficient operation of J-Link as well a3 flash
download modification of flash memory during a debug session as well as unlimited breakpoints in flash memary [Flash

Breakpoints). Cancel
In case of doubt, select the first entry in the list: "Unspecified Device' oK

3. Use the aforementioned code to enter the debug environment, and run the code step by step,
and then the print information will be displayed in the JLIinkRTTViewer window, as shown in
Figure 15.

Figure 15. JLinkRTTViewer window output information

A J-Link RTT Viewer V6.34c = (@ ][==

Loz | #11 Terminals | Terminal O

T
T
T
T
T
T
T
T
T

HHHHHAHA

Enter || Clear

RTT Viewer connected. 0.000 MB
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Notes

B Only J-Link can be used for the testing in sections 2.3 and 2.6; AT-Link is not supported.

B For the testing in section 2.1 and 2.2, if AT-Link is used, in the Options>CMSIS DAP->Reset,
either Hardware or System must be selected; otherwise, it will not be able to connect and
download the code.

B For the testing in section 2.2, in the Options—>General Options—>Library
Configuration->Library, Full must be selected; otherwise, it cannot be output. Only when the
Full is selected, can the codes that support Printf be available.

B For the testing in section 2.6.5.1, the program in the output window cannot designate the

device temporarily, so the ST part number have to be selected in the Device option at present,
and the “Use MicroLIB” in “Options” must be ticked; otherwise, the code compiling may be
abnormal.
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4 Revision history

Table 11. Document revision history

Date Version Revision note

2021.12.07 2.0.0 |Initial release
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